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ABSTRACT 

 
 

Water is the most important resource for crop production and due to high 

demand of agricultural sector scarcity of water is increasing day by day. Water scarcity 

is becoming a major problem for sustainable crop production as it is over-used to meet 

the high demands of agriculture. Clay pot irrigation consists of baked unglazed clay 

pots buried up to the neck in the soil and filled with water. This method is one of the 

most efficient irrigation systems known and is ideal for many small farmers. Clay pot 

irrigation, commonly referred as Pitcher irrigation is a conventional method of 

irrigation and is the latest development and effective revolution in local irrigation 

methods, this has been found sustainable for areas where scarcity of water is major 

problem on crop production. Using this method improves soil physical properties, like 

soil fertility, soil structural condition, and soil organic carbon. 

 

This project presents an Automated Pot Irrigation & IoT based monitoring 

system for irrigation using a Node MCU. The aim of this project is to explore the 

concept of a pot-based irrigation system using IoT, i.e., to develop a system that uses a 

Node MCU that processes data from an ultrasonic sensor that detects the water level in 

the pots and fills the pots automatically with water from the storage tank using an 

automatic solenoid valve and analyze the real-time water consumption of the plants and 

moisture content of soil using a smartphone with an internet connection. Research 

focuses mainly on crops and horticulture. In this project we use IOT to monitor the 

water level of pots using an ultrasonic sensor and to monitor the moisture content of 

soil. The limitations of this project as a whole is that the distance between the plants 

must be as large as possible to fit a pot between them, placing ultrasonic sensors on 

each plant can be expensive, to solve this problem in this project we connect the bottom 

of the pots to maintain a consistent water level in each pot, reducing complexity. 

 

 

Keywords: Soil organic carbon, Node MCU, Ultrasonic sensor, IOT, Solenoid valve. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 INTRODUCTION 

Irrigation is the most important input for growing crops that require high water 

supply in agriculture. Clay pot irrigation, a traditional system of irrigation alternative 

to drip method is the latest advancement and effective innovation of localized methods 

of irrigation and found suitable where water scarcity becomes major stress for crop 

production. Pitcher irrigation is a self-regulative, low cost and eco-friendly technique 

of irrigation having a high potential of energy saving, water saving and very much 

efficiency in orchard planting. 

  

Automated Pot Irrigation and IoT-Based Monitoring System is a modern solution to the 

age-old problem of efficiently irrigating plants while minimizing water wastage. With 

the advancement of technology, automated irrigation systems have become more 

popular and accessible to farmers and hobbyists alike. These systems use various 

sensors and IoT devices to monitor the moisture levels of the soil and the environmental 

conditions around the plant and adjust the irrigation accordingly. 

 

This documentation aims to provide a comprehensive overview of the Automated Pot 

Irrigation and IoT-Based Monitoring System, its components, and its implementation. 

It will cover the benefits of using such a system, the components of the system, how to 

set it up, and how to monitor and control the irrigation process remotely. Additionally, 

it will discuss various case studies and examples of successful implementation of this 

technology in different settings. 

 

By automating the irrigation process and using IoT-based monitoring, farmers and 

hobbyists can save water, reduce labor costs, and increase crop yields. This technology 

has the potential to revolutionize the way we irrigate plants, making it more efficient, 

sustainable, and profitable. With the information provided in this documentation, 
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readers can gain a better understanding of Automated Pot Irrigation and IoT-Based 

Monitoring System and how it can be implemented in their own settings. 

 

1.2 CLAY POT IRRIGATION 

Clay pot irrigation is a time-tested method of delivering water to plants that has 

been used for centuries in many parts of the world. The process involves burying 

unglazed clay pots or vessels filled with water in the soil near the roots of the plants. 

The clay pots are porous, meaning they allow water to slowly seep out, providing a 

consistent supply of moisture directly to the plant's roots. It is also known as Pitcher 

Irrigation. 

 

The basic principle behind clay pot irrigation is based on capillary action, which is the 

ability of water to move through small spaces. When a clay pot is buried in the soil, the 

water inside the pot moves through the tiny pores in the clay and is drawn towards the 

roots of the plant, where it is absorbed. This process continues until the water inside the 

pot is used up or until the soil around the pot is fully saturated. 

 

 

Fig 1.1 Clay Pot Irrigation. 

 

One of the main benefits of clay pot irrigation is that it can be an efficient use 

of water. Since the water is delivered directly to the plant's roots, it is not lost to 
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evaporation or runoff, which can occur with other watering methods. This also helps to 

reduce the frequency of watering needed, as the soil around the plant can retain moisture 

for longer periods of time. 

                                                   

Another benefit of clay pot irrigation is that it can help to reduce the risk of 

overwatering, which can be harmful to plants. With traditional watering methods, it can 

be difficult to control the amount of water delivered to the plant, leading to the risk of 

overwatering. However, with clay pot irrigation, the water is delivered slowly and 

consistently, reducing the risk of overwatering and waterlogging. 

Clay pot irrigation can also be a low-cost and sustainable solution for gardeners, as the 

clay pots can be reused for many years. Additionally, it can be a particularly useful 

method of watering for areas with water scarcity, as it can help to conserve water and 

ensure that plants receive the moisture they need to thrive. 

 

In summary, clay pot irrigation is a simple and effective method of watering plants that 

has been used for centuries. By delivering water directly to the roots of the plant and 

reducing the risk of overwatering, this method of irrigation can help to conserve water 

and promote healthy plant growth. 

 

1.2.1 Conditions for Clay Pot Irrigation  

i. Soil type: Clay pot irrigation is suitable for a variety of soil types, including 

sandy, loamy, and clay soils. However, it is important to ensure that the soil is 

well-drained to prevent waterlogging, which can be harmful to plants. 

 

ii. Climate: Clay pot irrigation is suitable for a variety of climates, including hot 

and dry climates. However, in areas with high humidity or heavy rainfall, the 

water inside the clay pot may not be able to evaporate, leading to waterlogging. 

 

iii. Plant type: Clay pot irrigation is suitable for a variety of plants, including 

vegetables, flowers, and trees. However, it may not be suitable for plants that 

require very dry conditions, such as cacti and succulents. 
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iv. Pot type and size: The type and size of the clay pot used for irrigation can 

impact its effectiveness. Unglazed clay pots are recommended, as they allow 

water to slowly seep out of the pot. The size of the pot should also be appropriate 

for the size of the plant being watered, as larger pots will deliver more water 

than smaller pots. 

v. Water source: The water used for clay pot irrigation should be clean and free 

from contaminants, such as chemicals or bacteria. Rainwater or well water is 

often a good choice for clay pot irrigation. 

 

vi. Frequency of watering: The frequency of watering with clay pot irrigation will 

depend on a variety of factors, including the climate, soil type, and plant type. 

In general, it is recommended to water plants with clay pot irrigation once a 

week or as needed, depending on the soil moisture level. 

 

vii. Placement of pots: The placement of the clay pots in the soil is important for 

effective irrigation. The pots should be buried in the soil near the roots of the 

plant, with the top of the pot at or slightly above the soil level. This will ensure 

that the water is delivered directly to the plant's roots. 

 

viii. Maintenance: Regular maintenance is important for effective clay pot 

irrigation. This may include cleaning the pots, checking the water level in the 

pots, and replacing the water as needed. 

 

Adopting clay pot irrigation requires consideration of a variety of conditions, 

including soil type, climate, plant type, pot type and size, water source, frequency of 

watering, placement of pots, and maintenance. By carefully considering these factors, 

gardeners can effectively use clay pot irrigation to promote healthy plant growth and 

conserve water in areas with water scarcity. 
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1.2.2 Advantages of Clay Pot Irrigation 

i. Efficient use of water: Clay pot irrigation delivers water directly to the plant's 

roots, reducing the amount of water lost to evaporation or runoff. This makes it 

an efficient use of water and can help conserve water in areas with water 

scarcity. 

 

ii. Reduces the risk of overwatering: With traditional watering methods, it can 

be difficult to control the amount of water delivered to the plant, which can lead 

to overwatering and waterlogging. However, with clay pot irrigation, the water 

is delivered slowly and consistently, reducing the risk of overwatering and 

promoting healthy plant growth. 

 

iii. Saves time and effort: Since clay pot irrigation delivers water directly to the 

plant's roots, it reduces the need for frequent watering and can save time and 

effort for gardeners. 

 

iv. Low cost and sustainable: Clay pots can be reused for many years, making 

clay pot irrigation a low-cost and sustainable solution for watering plants. 

 

 

v. Suitable for a variety of plants: Clay pot irrigation can be used for a variety 

of plants, including vegetables, flowers, and trees. It is particularly useful for 

plants that require consistent moisture, such as tomatoes and peppers. 

 

vi. Prevents weed growth: Since clay pot irrigation delivers water directly to the 

plant's roots, it can help prevent weed growth by reducing the amount of 

moisture in the soil that weeds require to germinate. 

vii. Improves soil structure: Clay pot irrigation promotes healthy soil structure by 

delivering water directly to the plant's roots. This can help prevent soil erosion 

and improve soil fertility. 
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viii. Reduces the risk of disease: By reducing the amount of water on the leaves of 

the plant, clay pot irrigation can help reduce the risk of disease caused by fungal 

or bacterial infections. 

 

ix. Can be combined with other watering methods: Clay pot irrigation can be 

used in conjunction with other watering methods, such as drip irrigation or 

sprinklers, to provide plants with a consistent supply of moisture. 

 

1.2.3 Drawbacks 

i. Limited coverage: Clay pot irrigation is suitable for small areas and individual 

plants, but it may not be practical for larger gardens or agricultural fields. 

 

ii. Time-consuming setup: Setting up clay pot irrigation can be time-consuming, 

as each pot must be buried in the soil and filled with water. 

 

iii. Risk of clogging: The small pores in the clay pots can become clogged with 

dirt or other debris, reducing their effectiveness and requiring more frequent 

cleaning. 

 

iv. Risk of breakage: Clay pots can be fragile and may break if they are not 

handled carefully during installation or maintenance. 

 

v. Inconsistent water delivery: The rate of water delivery with clay pot irrigation 

can vary depending on factors such as soil type, pot size, and placement, leading 

to uneven moisture levels in the soil. 

 

 

vi. High initial cost: Although clay pot irrigation is a sustainable solution, the 

initial cost of purchasing clay pots and setting up the irrigation system can be 

higher than other irrigation methods, such as sprinklers or drip irrigation. 
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vii. Susceptibility to freezing: In colder climates, clay pots may be susceptible to 

freezing during the winter, which can damage the pots and reduce their 

effectiveness. 

 

viii. Maintenance requirements: Regular maintenance is required to keep the clay 

pots clean and free from clogs, which can be time-consuming for larger gardens 

or agricultural fields. 

 

Clay pot irrigation has some drawbacks that may limit its use in certain 

situations. However, for small gardens or individual plants, clay pot irrigation can be a 

sustainable and efficient way to deliver water directly to the plant's roots while 

conserving water. By carefully considering the limitations and maintenance 

requirements of clay pot irrigation, gardeners can determine if it is a suitable irrigation 

method for their needs. 

 

1.2.4 Installation and Setup 

A step-by-step guide for the installation and setup of clay pot irrigation. 

Materials needed: 

1. Clay pots (the number and size will depend on the area you are irrigating and 

the size of the plants) 

2. Hose or other water source 

3. Watering can or bucket 

 

Steps to Follow: 

i. Choose the right pots: Select clay pots that are porous and unglazed, with a 

hole in the bottom for water to flow out. The size of the pot will depend on the 

size of the plant you want to irrigate. 

 

ii. Prepare the pots: Soak the pots in water for at least 30 minutes before 

installation. This will help prevent air pockets in the soil and ensure the pots are 

fully saturated before planting. 
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iii. Dig holes: Dig holes in the soil where you want to place the pots. The holes 

should be slightly larger than the pots to allow for easy placement. 

 

iv. Place the pots: Place the pots into the holes and bury them up to the neck of the 

pot, leaving the top of the pot exposed. The soil should be packed tightly around 

the pot to prevent air pockets. 

 

v. Fill the pots with water: Fill the pots with water using a watering can or bucket. 

The water will slowly seep through the pores of the clay and irrigate the soil 

around the plant. Make sure to fill the pots regularly to maintain a consistent 

water supply. 

 

vi. Check the water level: Check the water level in the pots regularly to make sure 

they do not dry out. Refill the pots with water as needed to maintain a consistent 

water supply. 

 

vii. Adjust the watering frequency: The frequency of watering will depend on the 

climate, soil type, and the size of the pot. For hot and dry conditions, the pots 

may need to be filled more frequently. In cooler and more humid conditions, the 

pots may need to be filled less often. 

 

viii. Adjust the placement of the pots: If the plants are not getting enough water, 

try adjusting the placement of the pots. Move them closer to the plants or place 

additional pots around the area to provide more water. 

 

ix. Maintenance: Regularly check the pots for clogs or damage, and clean them as 

needed. The pots may become clogged with soil or debris over time, reducing 

their effectiveness. Cleaning the pots can help ensure that they continue to 

deliver water to the plants effectively. 
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By following these steps, you can install and set up a clay pot irrigation system 

to efficiently and sustainably irrigate your plants. Remember to monitor the pots 

regularly and adjust the watering frequency as needed to maintain optimal plant growth 

and health. 

 

1.2.5 Maintenance 

i. Clean the pots regularly: Over time, clay pots can become clogged with soil 

or debris, reducing their effectiveness in delivering water to the plants. To 

prevent this, it is important to clean the pots regularly. Use a brush or cloth to 

gently scrub the inside and outside of the pots, removing any buildup of dirt or 

sediment. 

 

ii. Check the water level: Regularly check the water level in the pots to make sure 

they do not dry out. Refill the pots with water as needed to maintain a consistent 

water supply. The frequency of filling the pots will depend on the climate, soil 

type, and the size of the pot. 

 

iii. Check for clogs or damage: Check the pots for any signs of damage or clogs. 

If a pot is cracked or broken, it may need to be replaced. If a pot is clogged, use 

a small wire or toothpick to remove any debris that may be blocking the flow of 

water. 

 

iv. Adjust the watering frequency: Adjust the frequency of watering as needed, 

based on changes in weather or other factors. In hot and dry conditions, the pots 

may need to be filled more frequently. In cooler and more humid conditions, the 

pots may need to be filled less often. 

 

v. Adjust the placement of the pots: If the plants are not getting enough water, 

try adjusting the placement of the pots. Move them closer to the plants or place 

additional pots around the area to provide more water. 
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vi. Monitor plant growth and health: Regularly monitor the growth and health 

of the plants to ensure that they are receiving adequate water. If the plants are 

showing signs of stress or wilting, they may not be getting enough water and 

adjustments may need to be made to the clay pot irrigation system. 

 

vii. Winter storage: If you live in a cold climate, you may need to store the clay 

pots during the winter months to prevent them from cracking due to freezing 

temperatures. Clean the pots thoroughly and store them in a dry, protected area 

until the weather warms up again. 

 

1.2.6 Tips for Successful Clay Pot Irrigation 

i. Choose the right pots: Use unglazed clay pots that are porous and have a hole 

in the bottom for water to flow out. Make sure the size of the pot is appropriate 

for the size of the plant. 

 

ii. Soak the pots before installation: Soak the pots in water for at least 30 minutes 

before installation. This will help prevent air pockets in the soil and ensure the 

pots are fully saturated before planting. 

 

iii. Install the pots correctly: Bury the pots up to the neck, leaving the top of the 

pot exposed. Pack the soil tightly around the pot to prevent air pockets. 

 

iv. Fill the pots with water: Fill the pots with water using a watering can or bucket, 

and make sure the water level is maintained at all times. 

 

v. Monitor plant growth and health: Regularly monitor the growth and health 

of the plants to ensure that they are receiving adequate water. Adjust the 

watering frequency as needed, based on changes in weather or other factors. 

 

vi. Use a cover crop: Plant a cover crop around the pots to help retain moisture 

and prevent the soil from drying out. 
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vii. Consider adding fertilizer: Clay pot irrigation can be more effective when 

combined with a slow-release fertilizer, which can be added to the soil before 

planting. 

 

viii. Use mulch: Mulch around the base of the plant to help retain moisture and 

reduce evaporation. 

 

ix. Position the pots correctly: Place the pots close to the plants that need to be 

watered, and position them in areas that receive adequate sunlight. 

 

x. Clean the pots regularly: Regularly clean the pots to prevent clogs and 

blockages in the water flow. 

 

1.3 COMPARISON TO OTHER METHODS 

i. Drip Irrigation: Drip irrigation systems use a network of tubes or pipes with 

small holes or emitters to deliver water directly to the plant roots. Unlike clay 

pot irrigation, drip irrigation systems require a larger initial investment and can 

be more complex to install. However, they can be more efficient in water usage, 

as they allow for more precise control over the amount of water delivered to 

each plant. 

 

ii. Sprinkler Irrigation: Sprinkler irrigation systems spray water over a large 

area, similar to rainfall. They are often used for larger agricultural or landscape 

irrigation projects, and can be less efficient in water usage than other methods. 

Unlike clay pot irrigation, sprinkler systems can be prone to evaporation, which 

can reduce their effectiveness in delivering water to the plants. 

 

iii. Flood Irrigation: Flood irrigation involves flooding a field or area with water 

and allowing the water to seep into the soil. This method can be less efficient in 

water usage and can lead to soil erosion and nutrient loss. Unlike clay pot 
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irrigation, flood irrigation can also be difficult to control, which can result in 

overwatering or underwatering. 

 

iv. Manual Watering: Manual watering involves using a watering can or hose to 

deliver water to plants. While this method is simple and easy to use, it can be 

time-consuming and may not be as efficient in water usage as other methods. 

Unlike clay pot irrigation, manual watering also requires regular monitoring and 

can be prone to overwatering or underwatering. 

 

Compared to these other irrigation methods, clay pot irrigation is relatively 

simple and low-cost to install and maintain. It is also an effective way to conserve water 

and deliver it directly to the plant roots. However, it may not be as efficient in water 

usage as other methods like drip irrigation, and may not be as effective for larger 

agricultural or landscape irrigation projects. Ultimately, the choice of irrigation method 

will depend on a variety of factors, including the size of the project, the type of plants 

being grown, and the local climate and soil conditions. 

 

1.4 AUTOMATED POT IRRIGATION 

This project presents an Automated Pot Irrigation & IoT based monitoring system 

for irrigation using a Node MCU. The aim of this project is to explore the concept of a 

pot-based irrigation system using IoT, i.e., to develop a system that uses a Node MCU 

that processes data from an ultrasonic sensor that detects the water level in the pots and 

fills the pots automatically with water from the storage tank using an automatic solenoid 

valve and analyze the real-time water consumption of the plants and moisture content 

of soil using a smartphone with an internet connection. Research focuses mainly on 

crops and horticulture. In this project we use IOT to monitor the water level of pots 

using an ultrasonic sensor and to monitor the moisture content of soil. The limitations 

of this project as a whole is that the distance between the plants must be as large as 

possible to fit a pot between them, placing ultrasonic sensors on each plant can be 

expensive, to solve this problem in this project we connect the bottom of the pots to 

maintain a consistent water level in each pot, reducing complexity. 
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CHAPTER 2 

HARDWARE REQUIRED 

 

2.1 COMPONENTS REQUIRED 

 
➢ Node MCU esp8266 
➢ Relay module 
➢ Ultrasonic Sensor 
➢ Capacitive Moisture Sensor 
➢ Solenoid Valve 
➢ 12V DC adapter 
➢ PVC pipes 
➢ Connecting Jumper wires 

 

 

2.2 NODE MCU: 

 

2.2.1 About Node MCU:  
NodeMCU is an open-source firmware and development board designed for IoT 

applications. It is based on the ESP8266 Wi-Fi module and features an easy-to-use 

interface for prototyping IoT projects. The NodeMCU board has built-in Wi-Fi 

connectivity, with IEEE 802.11 b/g/n support and a range of up to 100m in open space.  

 

 

Fig 2.1 Node_MCU ESP8266 

 

It can be programmed using Lua scripting language or the Arduino IDE, making 

it ideal for beginners and professionals alike. The board has 11 digital input/output pins 

and one analog input pin, which can be used to interface with sensors, actuators, and 
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other electronic components. Additionally, the NodeMCU board has an integrated 

USB-to-serial converter, making it easy to program and interface with a computer. The 

board can be powered using a USB cable or an external power supply, with a voltage 

range of 4V to 9V. It also has a built-in voltage regulator that allows it to operate from 

a wide range of power sources. 

 

The NodeMCU board has 4MB flash memory, which can be used to store 

firmware and data, and 80KB of RAM for program execution. It supports OTA (Over-

The-Air) programming, allowing firmware updates to be performed remotely. Other 

specifications include clock speed of up to 80MHz, 3.3V logic level, SPI, I2C, and 

UART communication protocols, and support for SSL/TLS encryption for secure 

communication. The board also has a micro-USB port, a reset button, and an LED 

indicator. It can be used with a variety of sensors and actuators, such as temperature 

and humidity sensors, motion detectors, and relay modules. Overall, the NodeMCU 

board is a versatile and powerful platform for building IoT applications due to its ease 

of use, flexibility, and low cost. It is an ideal choice for hobbyists, students, and 

professionals looking to create innovative IoT projects. 

 

2.2.2 Pin Configuration of Node MCU 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 

 

 
     Fig 2.2 Node_MCU Pin diagram 
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1. Power Pins: 

NodeMCU has two power pins, labeled as 3V3 and GND. The 3V3 pin 

provides a regulated output of 3.3 volts, which is used to power the board and 

connected peripherals. The GND pin is the ground connection for the board and 

connected peripherals. 

2. Analog Pins: 

NodeMCU has one analog input pin, labeled as A0. This pin can be used 

to read analog signals from sensors, such as light sensors, temperature sensors, 

and more. The analog input pin has a maximum input voltage of 3.3V. 

3. Digital Pins 

NodeMCU has 17 digital pins, labeled as GPIO0 to GPIO16. These pins 

can be configured as inputs or outputs, and can be used to interface with a wide 

range of electronic components, such as sensors, LEDs, relays, and more. These 

pins operate at a voltage of 3.3V, which is compatible with most electronic 

components.  

4. ADC Channel 

NodeMCU has one analog input pin, A0, connected to a 10-bit resolution 

ADC module. It is used to read analog signals from sensors, and can measure 

voltage levels from 0 to 3.3V. The analogRead() function can be used to read the 

input voltage on the A0 pin. A low-pass filter or averaging can be used to improve 

measurement accuracy due to possible introduced noise by the ADC module. 

5. I2C pins 

NodeMCU has SDA (data line) and SCL (clock line) pins for I2C 

communication, connected to GPIO4 and GPIO5 respectively. The I2C protocol 

allows for two-wire communication between microcontrollers and other devices, 
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such as sensors. The SDA pin is used for data transmission, while the SCL pin is 

used for clock synchronization. The I2C interface supports multiple devices on 

the same bus using different addresses, and can be configured using the Wire 

library in Arduino IDE or the corresponding Lua functions. 

6. UART Pins 

NodeMCU has two pins, labeled TXD (transmit) and RXD (receive), 

which are used for UART communication. They are connected to GPIO1 and 

GPIO3, respectively, on the ESP8266 module. The UART protocol is used for 

asynchronous serial communication between devices, such as microcontrollers 

and computers, using two wires for data transmission. The TXD pin is used for 

transmitting data, while the RXD pin is used for receiving data. The UART pins 

can be configured using the Serial library in Arduino IDE or the corresponding 

Lua functions. 

7. Control Pins 

These pins are used to control ESP8266. These pins include Chip Enable pin 

(EN), Reset pin (RST) and WAKE pin. 

8. EN pin 

The ESP8266 chip is enabled when EN pin is pulled HIGH. When pulled LOW 

the chip works at minimum power. 

9. RST pin 

RST pin is used to reset the ESP8266 chip. 

10. WAKE pin 

Wake pin is used to wake the chip from deep sleep. 
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2.2.3 Power Requirement 

 
The power requirements of NodeMCU depend on various factors, such as the 

power source, the connected peripherals, and the operating conditions. However, in 

general, NodeMCU requires a voltage supply between 4.5V to 9V, and a minimum 

current of 500mA. The NodeMCU board includes a built-in voltage regulator that can 

handle input voltages up to 12V, but it is recommended to use a stable power supply to 

avoid voltage fluctuations that can cause issues with the board's performance. When 

operating the NodeMCU with Wi-Fi enabled and connected to a network, it can consume 

up to 200mA of current, depending on the signal strength and the data transfer rate. 

Therefore, it is important to use a power supply that can provide sufficient current to 

avoid stability issues or resets. It is also recommended to avoid connecting high-power 

peripherals directly to the NodeMCU's GPIO pins, as this can cause voltage drops and 

affect the stability of the board. Instead, it is recommended to use external power sources 

or voltage level shifters, if needed. 

 

 

2.2.4 NodeMCU ESP8266 Specifications & Features: 

 

Specifications 

 

➢ Microcontroller: Tensilica 32-bit RISC CPU Xtensa LX106, ESP8266EX  

➢ Clock Speed: 80MHz  

➢ Flash Memory: 4MB  

➢ Wi-Fi Protocol: 802.11 b/g/n  

➢ Wi-Fi Frequency: 2.4 GHz  

➢ Operating Voltage: 3.3V  

➢ GPIO Pins: 17  

➢ Analog Input Pins: 1 (maximum input voltage 3.3V)  

➢ I2C Interface: Yes  

➢ SPI Interface: Yes  

➢ UART Interface: Yes  
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➢ ADC Resolution: 10-bit  

➢ Maximum Current: 500mA 

 

Features 

 

 

➢ Operating Voltage: 3.3V 

➢ Built-in Wi-Fi module with antenna 

➢ Support for TCP/IP protocols  

➢ Built-in Lua interpreter for easy programming  

➢ Support for Arduino IDE, MicroPython, and Node.js  

➢ Easy access to GPIO, I2C, SPI, and UART interfaces  

➢ Support for PWM (Pulse Width Modulation) output  

➢ Support for one-wire interface  

➢ USB interface for power and programming  

➢ Integrated voltage regulator  

➢ Breadboard-friendly design  

➢ Low cost and easy to use 

 

2.2.5 Applications of Node MCU 

➢ Prototyping of IoT devices 

➢ Low power battery operated applications 

➢ Network projects 

➢ Projects requiring multiple I/O interfaces with Wi-Fi and Bluetooth 

functionalities. 

➢ Smallest IoT Home Automation using ESP8266 – 01 with Vide 

➢ Geolocation using ESP8266.  

➢ ESP8266 Projects: Wireless Web Server. ... 

➢ World's smallest IoT project. ... 

➢ Air Pollution Meter. ... 

➢ Humidity and temperature monitoring. 
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2.3 RELAY MODULE 

2.3.1 About Relay Module 

The relay module is an electrically operated switch that can be turned on or off deciding 

to let current flow through or not. They are designed to be controlled with low voltages 

like 3.3V like the ESP32, ESP8266, etc, or 5V like your Arduino. 

                                                   

Fig 2.3 Relay Module 

 

Relay is one kind of electro-mechanical component that functions as a switch. The relay 

coil is energized by DC so that contact switches can be opened or closed. A single 

channel 5V relay module generally includes a coil, and two contacts like normally open 

(NO) and normally closed (NC) 

 

2.3.2  Pin Configuration  

 

                                         

 

Fig 2.4 Pin Configuration of Relay Module 

1) VCC: This pin is used to supply power to the relay module. It is typically 

connected to the positive terminal of the power supply, and can accept a voltage 

between 5V and 12V, depending on the module.  
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2) GND: This pin is connected to the ground terminal of the power supply and 

provides the ground reference for the entire circuit. 

 

3) IN: This pin is used to control the relay. It accepts a logic-level input signal 

from a microcontroller or other control circuit and is used to switch the relay on 

and off.  

 

4) COM: This pin is the common pin of the relay and is connected to one end of 

the load that needs to be switched. When the relay is activated, the COM pin is 

connected to either the NO or NC pin, depending on the type of relay.  

 

5) NO/NC: These pins are the output pins of the relay and are connected to the 

other end of the load that needs to be switched. The NO (Normally Open) pin is 

connected to the COM pin when the relay is activated, and the NC (Normally 

Closed) pin is disconnected from the COM pin when the relay is activated. 

 

2.3.3 Working of Relay Module 

A relay module is an electronic device that is used to switch high-voltage or 

high-current circuits using low-voltage or low-current control signals. The relay module 

consists of a relay, a driver circuit, and some additional components for protection and 

isolation. The relay itself is an electromagnetic switch that consists of a coil and one or 

more contacts. When a current is applied to the coil, it generates a magnetic field that 

attracts the contacts and closes the circuit. When the current is removed from the coil, 

the contacts return to their original position and open the circuit. The driver circuit in 

the relay module is responsible for controlling the current to the relay coil based on the 

control signals received from a microcontroller or other control device. The driver 

circuit typically consists of a transistor or a solid-state relay that can handle the current 

required by the relay coil. The additional components in the relay module provide 

protection and isolation between the control circuit and the high-voltage or high-current 

circuit being controlled. These components may include diodes for protection against 
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voltage spikes and optocouplers for electrical isolation. To use a relay module, you 

would typically connect the control signal to the input pins of the module and connect 

the high-voltage or high-current circuit to the output pins of the module. When the 

control signal is activated, the relay module will switch the high-voltage or high-current 

circuit on or off depending on the configuration of the module. 

 

2.3.4 Specifications of Relay Module 

➢ Input voltage: 5V DC  

➢ Input current: 70mA  

➢ Maximum switching voltage: 250V AC / 30V DC  

➢ Maximum switching current: 10A  

➢ Maximum switching power: 1200W  

➢ Relay lifespan: 100,000 cycles  

➢ Operating temperature range: -40°C to +70°C  

➢ Dimensions: 25mm x 34mm x 25mm  

➢ Weight: 14g 

 

2.3.5 Features of Relay Module 

➢ Easy to use: Relay modules are designed to be easy to use and can be 

integrated with a variety of microcontrollers or other control circuits.  

➢ Low power consumption: Relay modules typically have low power 

consumption, making them ideal for use in battery-powered applications.  

➢ High switching capacity: Relay modules are capable of switching high 

voltages and currents, making them ideal for controlling larger loads such as 

motors and lights.  

➢ Multiple channels: Many relay modules have multiple channels, allowing you 

to control multiple loads simultaneously.  

➢ Opto-isolation: Relay modules often use opto-isolation to protect the control 

circuit from voltage spikes or other electrical noise that can damage sensitive 

components.  
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➢ LED indicators: Most relay modules have LED indicators to show the status of 

the relay, making it easy to troubleshoot and debug your circuit.  

➢ Small size: Relay modules are often compact and easy to integrate into your 

projects, making them ideal for use in space-constrained applications. 

 

2.4 ULTRASONIC SENSOR 

 

2.4.1 About Ultrasonic Sensor 

Ultrasonic sensors are devices that use sound waves to measure distance and 

detect objects. They emit high-frequency sound waves and then detect the waves that 

bounce back. By measuring the time it takes for the sound waves to bounce back, the 

sensor can determine the distance to the object. Ultrasonic sensors are commonly used 

in a wide range of applications, including robotics, automation, and automotive 

industry. 

 

                                             
Fig 2.5 Ultrasonic Sensor 

 

2.4.2 Principle of Ultrasonic Sensor 

Ultrasonic sensors operate by emitting high-frequency sound waves that bounce 

back from objects in their path. The sensor measures the time it takes for the sound 

waves to return to the sensor and uses this information to calculate the distance to the 

object. The ultrasonic sensor consists of a transducer and a receiver. The transducer 

emits the sound waves and then switches to receive mode to detect the waves that 

bounce back. The receiver then sends a signal to a microcontroller, which calculates the 
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distance to the object based on the time it takes for the sound waves to travel to and 

from the object. 

Ultrasonic sensors typically consist of several components, including the 

transducer, receiver, and control circuit. 

The transducer is the heart of the ultrasonic sensor, as it converts electrical 

signals into sound waves. It is typically made of piezoelectric material, which generates 

an electric charge when subjected to pressure or mechanical stress. 

The receiver, also known as the detector, is responsible for receiving the sound 

waves that bounce back from objects. It is typically placed adjacent to the transducer 

and converts the sound waves into electrical signals. 

 

The control circuit processes the signals from the receiver and calculates the 

distance to the object. It also controls the timing and frequency of the sound waves 

emitted by the transducer. 

 

 
 

Fig 2.6 Pin Diagram and Working of Ultrasonic Sensor 

 

2.4.3 Pin Configuration and Features 

1) Vcc - The Vcc pin powers the sensor, typically with +5V 

2) Trigger - Trigger pin is an Input pin. This pin has to be kept high for 10us to 

initialize measurement by sending US wave. 
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3) Echo - Echo pin is an Output pin. This pin goes high for a period of time which 

will be equal to the time taken for the US wave to return back to the sensor. 

4) Ground - This pin is connected to the Ground of the system. 

 

                                     

Fig 2.7 Pin Diagram of Ultrasonic Sensor 

Features 

• Operating voltage: +5V 

• Theoretical Measuring Distance: 2cm to 450cm 

• Practical Measuring Distance: 2cm to 80cm 

• Accuracy: 3mm 

• Measuring angle covered: <15° 

• Operating Current: <15mA 

• Operating Frequency: 40Hz 

2.4.4 Applications of Ultrasonic Sensor 

Ultrasonic sensors are used in a wide range of applications, including robotics 

and automation, automotive industry, distance measurement, level sensing, medical 

imaging and diagnostics, industrial automation, and security systems. 

 

In the automotive industry, ultrasonic sensors are commonly used for parking 

sensors and collision avoidance systems. In the medical industry, they are used for 

medical imaging and diagnostics, such as ultrasound imaging. In industrial automation, 

they are used for detecting objects on conveyor belts. 
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2.4.5 Advantages and Limitations 

 

Advantages: 

One of the main advantages of ultrasonic sensors is their ability to detect objects 

without physically touching them. This makes them ideal for applications where contact 

with the object could cause damage or where physical contact is not possible. 

 

Ultrasonic sensors are also highly accurate, with the ability to measure distances 

with a high degree of precision. They can be used in a wide range of environments, 

including harsh and hazardous environments, and have low power consumption, 

making them suitable for battery-powered applications. 

 

Limitations: 

Despite their many advantages, ultrasonic sensors also have some limitations 

that should be considered when designing systems that use them. One limitation is their 

limited range, with maximum ranges typically between 5 and 10 meters.  

 

They are also sensitive to sound waves and interference from other ultrasonic 

sensors, which can lead to false readings. 

 

2.5 CAPACTIVE SOIL MOISTURE SENSOR 

2.5.1 About Capacitive Soil Moisture Sensor 

A Capacitive soil moisture sensor is a device that measures the moisture content 

in soil by using the principle of capacitance. It consists of two electrodes that are 

inserted into the soil. The amount of moisture present in the soil affects the dielectric 

constant of the soil, which in turn affects the capacitance between the two electrodes.  

 

The capacitive soil moisture sensor can be used in agriculture, horticulture, and 

environmental monitoring to determine when to water plants or crops. It is used to 
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improve irrigation efficiency, optimize crop yield, and reduce water usage, leading to a 

more sustainable use of water resources.  

 

One advantage of the capacitive soil moisture sensor is that it can measure 

moisture content at different depths of soil, providing a more comprehensive picture of 

soil moisture. Moreover, it is relatively easy to use and can be installed with minimal 

equipment and maintenance. 

                                 

    Fig 2.8 Capactive Moisture Sensor 

 

2.5.2 Pin Configuration 

The pin configuration of a capacitive soil moisture sensor typically consists of three 

pins:  

1) VCC - This pin is connected to the positive supply voltage, usually 3.3V or 5V.  

2) GND - This pin is connected to the ground or negative supply voltage. 

3) OUT - This pin is the output pin, which provides an analog or digital signal 

indicating the soil moisture level. The output signal may vary depending on the 

sensor model and the circuit design. Some sensors may provide a voltage output, 

while others may use a frequency or pulse-width modulation (PWM) output. 

 

2.5.3 Working of Sensor 

A capacitive soil moisture sensor works by measuring the dielectric constant of 

soil, which is related to the amount of moisture or water content in it. The sensor 

consists of two electrodes or plates, which are usually parallel to each other and are 
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separated by a small distance. When the sensor is inserted into the soil, the soil acts as 

a dielectric medium between the two electrodes.  

 

The capacitance of the sensor changes depending on the water content or 

moisture level in the soil. When the soil is wet or has high moisture content, the 

dielectric constant is high, and the capacitance of the sensor is also high. Conversely, 

when the soil is dry, the dielectric constant is low, and the capacitance of the sensor is 

low.  

 

The sensor is connected to a microcontroller or a computer, which reads the 

capacitance value and translates it into a corresponding moisture level or water content 

in the soil. This information can be used to control irrigation or watering systems, 

monitor plant health, and optimize crop yields. 

 

2.5.4 Specifications of Sensor 

 

• Moisture measurement range: The soil moisture sensor should be able to 

measure moisture levels across a wide range, typically from 0% to 100%. 

• Accuracy: The accuracy of the sensor is the measure of how close the sensor's 

output values are to the actual soil moisture levels. The accuracy of a capacitive 

soil moisture sensor can range from +/- 2% to +/- 5%.  

• Response time: This is the time it takes for the sensor to detect changes in 

moisture levels. Response times for capacitive soil moisture sensors can range 

from a few seconds to several minutes.  

• Output signal: Capacitive soil moisture sensors may provide either analog or 

digital output signals. Analog signals are continuous and provide a range of 

values while digital signals are non-continuous and typically provide a binary 

on/off output.  

• Power consumption: Capacitive soil moisture sensors typically require low 

power and can run on batteries or solar power.  
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• Material: The sensor's material should be durable and able to withstand harsh 

environmental conditions. Common materials include plastic, ceramic, and 

metal.  

• Operating temperature range: The sensor's operating temperature range 

should be listed to make sure it can withstand the environment it will be placed 

in.  

• Cable length: The length of the sensor's cable can range from a few inches to 

several feet, allowing placement options in various soil depths.  

• Calibration: Some capacitive soil moisture sensors may require calibration to 

ensure accuracy of measurements. Calibration instructions should be provided 

by the manufacturer. 

 

2.5.5 Applications of Sensor 

• Agriculture: In agriculture, capacitive moisture sensors are used for measuring 

the moisture content of soil to determine the optimal time for planting, 

irrigating, and fertilizing crops.  

• Construction: Capacitive moisture sensors are also used in the construction 

industry to test moisture levels in building materials like concrete, wood, and 

drywall, which can help prevent structural damage caused by moisture.  

• Food Processing: Capacitive moisture sensors are used in food processing 

plants to measure the moisture content of food products such as grains, 

vegetables, and meat. This helps to maintain the quality and freshness of the 

food products.  

• Environmental Monitoring: Capacitive moisture sensors are useful in 

monitoring the moisture content of the air, soil, and water, thereby helping to 

predict weather patterns, detect natural disasters, and monitor water levels in 

rivers and lakes. 
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2.6 Solenoid Valve 

A solenoid valve is an electromechanical device used to control the flow of 

fluids or gasses in a variety of industrial and commercial applications. It works by using 

an electromagnetic coil to actuate a plunger or piston, which opens or closes a valve.The 

basic components of a solenoid valve include an electromagnetic coil, a plunger or 

piston, a valve seat, and a fluid or gas port. When the coil is energized, it creates a 

magnetic field that causes the plunger or piston to move, which opens or closes the 

valve seat and allows or blocks the flow of fluid or gas through the port. 

 

Solenoid valves can be used for a wide range of applications, including 

controlling water, gas, oil, and other fluids in pipelines, controlling the flow of air in 

pneumatic systems, and controlling the flow of refrigerant in air conditioning and 

refrigeration systems. They can also be used in medical equipment, automotive 

systems, and industrial automation. 

 

When selecting a solenoid valve, it is important to consider factors such as the 

type of fluid or gas being controlled, the pressure and temperature of the system, and 

the required flow rate. Solenoid valves are available in a variety of materials, including 

brass, stainless steel, and plastic, to meet the needs of different applications. 

 

 

Fig 2.9 Solenoid Valve 
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In summary, a solenoid valve is an electromechanical device used to control the 

flow of fluids or gases in various industrial and commercial applications. It works by 

using an electromagnetic coil to actuate a plunger or piston, which opens or closes a 

valve. Solenoid valves come in different configurations and materials to meet the needs 

of different applications, and their selection depends on factors such as the type of fluid 

or gas being controlled, the pressure and temperature of the system, and the required 

flow rate. 

 

 In this project a 12v DC solenoid valve is used to control the water flow to pots from 

the overhead tank. 

 

 

 

2.7 12v DC Adapter 

 

A 12-volt DC adapter is an electronic device that provides a constant 12-volt 

direct current (DC) output to power or charge a variety of devices that require 12 volts. 

This adapter usually consists of a small, compact box that is plugged into an AC power 

outlet and has a cable or cord with a connector on the end that plugs into the device. 

12-volt DC adapters are commonly used to power a wide range of electronics, including 

routers, modems, gaming consoles, and small appliances. They can also be used to 

charge batteries, such as those found in smartphones and tablets. The voltage output of 

the adapter must always match the input voltage requirement of the device being 

powered to prevent damage to the device. 
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CHAPTER 3 

SOFTWARE REQUIRED 

 

3.1 BLYNK CLOUD 

 

3.1.1 About Blynk Cloud 

Blynk is an IoT platform for iOS or Android smartphones that is used to control 

Arduino, Raspberry Pi and NodeMCU via the Internet.  

 

 

3.1.2 Block Diagram of Blynk IOT 

 
 

 
 

Fig 3.1 Block Diagram of Blynk IOT 

 

 

 

Blynk was designed for the Internet of Things. It can control hardware remotely, it 

can display sensor data, it can store data, visualize it and do many other cool things. 
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3.1.3 COMPONENTS OF BLYNK IOT 

There are three major components in blynk IOT 

1. Blynk App 

2. Blynk Server 

3. Blynk Libraries 

 

Blynk App: – It allows you to create amazing interfaces for your projects using various 

widgets which are provided. 

 

Blynk Server: – It is responsible for all the communications between the smartphone 

and hardware. 

 

Blynk Libraries: – It enables communication, for all the popular hardware platforms, 

with the server and process all the incoming and outcoming commands. 

 

TEMPLATE: Template is a set of elements and configurations, used to display all 

Devices of a particular type. Templates are created by Developers and can be published 

to be accessible globally. 

 

 

CREATE PROJECT 

 

1. Go to create project.   

2. Enter the device name. 

3. Select the hardware device and connection type. 

4. Then the project is created 

ELEMENTS OF TEMPLATE: 

 

1. Template ID 

2. Data streams 

3. Events and notification setup 

4. Metadata 
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5. Web Dashboard 

6. Mobile Dashboard 

 

 
 

Fig 3.2 Elements of Template 

 

Template-ID 

The most important element of the template is TemplateID. This is a unique identifier 

for every template which should be specified in the code on your device. If you check 

the code, will be generated for your device. 

 

Datastreams 

Datastreams is a way to structure data that regularly flows in an out from device. Use it 

for sensor data, any telemetry, or actuators. 

There are 3 pins in Datastreams 

1. Virtual pin 

2. Location 

3. Enumerable 
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Virtual Pin: 

Virtual Pin is a concept invented to provide exchange of any data between hardware, 

web and mobile app. Virtual pins allow you to interface with any sensor, any library, 

any actuator. 

it's a very powerful feature to display and send any data from your hardware to the 

application. 

 

Location: 

It can be useful to collect Device coordinates data to view the places it was working at 

or to represent movements detailed data by building a GPS track in Map Widget. 

Enumerable: 

This datastream accepts a fixed set of values and transforms them into desired 

outcomes. 

 

 

WEB DASHBOARD 

A set of UI elements (widgets) to visualize the data from the device accessible for the 

users in Blynk.Console – a web-based application. 

 

MOBILE DASHBOARD 

Metadata is a set of UI elements (widgets) to visualize the data in Blynk mobile apps 

for iOS and Android. Mobile apps also contain a template of how device is represented 

in the list of devices (tiles). 

 

METADATA 

Metadata is a set of key:value data attached to every device. Keys are static, and 

values are related for each device.  

Metadata can be edited by users based on their access level. 

Default value can be set to each Metadata, be changed during Add Device procedure 

and edited any time later. 
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There are 5 info present in metadata. 

 

1. Device Name – here you can type default Device name.  

2. Device Owner – here you can type default Device Owner name or Email.  

3. Location – here you can type default Location name.  

4.  Device Timezone – select actual or preferred Timezone from the dropdown list 

5. Hotspot Name – here you can type default Hotspot name.  

 

 

3.2 Arduino sketch for Node_MCU: 

 

3.2.1 About Arduino IDE: 

 

Arduino IDE is software for progaming Arduino Board / Node_MCU. This software 
is used as a text editor to create, open, edit, and validate Code for Arduino. The Code 
or Program in Arduino is called "sketch". 
 
 

 

3.2.2 INSTALLING ARDUINO IDE IN WINDOWS 10: 
 

 

Step 1: Download Arduino IDE Installation file 

 

 Download from the Official Arduino Website  

 

1. Go to the official Arduino website: https://www.arduino.cc/en/software/  

2. Click on the "Windows Installer" button to download the installer for Windows.  

3. Once the download is complete, run the installer and follow the on-screen 

instructions to complete the installation process. 
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Step 2: Options of Installation 

 

 
 

Fig 3.3 Installation Options 

 

Step 3: Selection of Installation Folder 

 

 
 

Fig 3.4 Installation Folder Selection 

 

1. In the "Choose Install Location" screen, you can either accept the default 

installation path or click on "Browse" to select a different folder location.  

2. If you choose to select a different installation folder, navigate to the folder 

location where you want to install the Arduino IDE.  
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3. Once you have selected the installation folder, click on "OK" to confirm the 

selection.  

4. Finally, click on "Install" to begin the installation process.      

  

Step 4: Progress of Installation 

 

 
 

Fig 3.5 Arduino Setup Installing process window 

 

Step 5: Installation Complete 
 

 

 
 

Fig 3.6 Arduino Installation Complete Window 
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Step 6: Open Arduino IDE 

 
 

Fig 3.7 Open Arduino IDE  

 

After installing Arduino IDE software open it by clicking the Arduino icon on the Start 

Menu or Desktop if not found click on search and type "Arduino”.  Run the application. 

 

Step 7: Arduino IDE Display Window 

 

 
 

Fig 3.8 Arduino IDE Display Window 
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3.2.3 Programming NodeMCU using Arduino IDE 

 

 

Step 1.  

1. Connect your NodeMCU to your computer using a USB cable.  

2. Open the Arduino IDE and go to "File" > "Preferences".  

3. In the "Additional Boards Manager URLs" field, enter the following URL and 

click "OK": 

http://arduino.esp8266.com/stable/package_esp8266com_index.json 

 

 
 

Fig 3.9 Program NodeMCU using Arduino IDE 

 

 

 

Step 2: 

 

1. Go to "Tools" > "Board" > "Boards Manager".  

2. In the "Boards Manager" window, search for "esp8266" and click on the 

"esp8266" option.  
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3. Click on the "Install" button to install the ESP8266 boards package. 

 

 
 

Fig 3.10 Installing Esp8266 Packages 

 

 

Step 3: 

 

1. Go to "Tools" > "Board" and select "NodeMCU 1.0 (ESP-12E Module)" as your 

board.  

2. Go to "Tools" > "Port" and select the COM port to which your NodeMCU is 

connected.  

3. Write your code in the Arduino IDE.  

4. Click on the "Upload" button to upload your code to the NodeMCU. 
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CHAPTER 4 

METHODOLOGY 

 

4.1 Automated Pot Irrigation and IOT Based Monitoring System 

 

4.1.1 Block Diagram  

 

 

 

Fig 4.1 Block Diagram of Automated Pot Irrigation System 
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4.1.2 Working Principle  

The working principle of Pot irrigation is based on the principle of capillary 

action. Capillary action refers to the ability of a liquid to flow in narrow spaces without 

the assistance of, and sometimes in opposition to, external forces like gravity. In the 

case of pitcher irrigation, the porous walls of the clay pot create narrow spaces that 

allow water to flow through them due to capillary action. 

 

The water in the pots is drawn out by the dry soil surrounding the pots, and the 

moistened soil forms a cone of wetness around the pots. This cone of wetness extends 

downwards and outwards as the soil dries out, providing a steady supply of water to the 

plants' roots. 

 

4.1.3 Implementation of Automated Pot Irrigation System  

  

Initial Arrangement at Farm  

 

As the project is based on pitcher irrigation it is necessary to bury pots before 

planting crops. The number of pots required, arrangement and the spacing between pots 

depends upon the type of crop that is planted. Apart from the number of pots required 

and spacing between them, the burred pots should be connected at bottom and as farms 

are even land all the pots should be burried upto constant level so that the water in pots 

can be filled simultaneously and evenly [8]. This arrangement facilitates detecting water 

levels of all pots in one measurement from single pot at a time.  

 

 

Fig 4.2  Initial Pots Arrangement Setup. 
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Hardware Implementation 

 

Fig 4.3 shows the hardware implementation diagram of IoT based water level 

controlling system. This hardware system consists of a capacitive soil-moisture sensor, 

a microcontroller, a solenoid valve, an adapter, an ultrasonic sensor, a pump, and a relay 

module that controls the solenoid valve of the hardware. The microcontroller in the 

picture uses a NodeMCU which is based on ESP8266 wifi module, this microcontroller 

creates trigger that causes the relay-controlled switch to close and open. 

 

 

 
Fig 4.3 Hardware Implementation of water level detection in pots 
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Circuit Diagram of Hardware setup 

 
 

 
Fig 4.4 Circuit Diagram of Hardware setup   
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An ultrasonic sensor is placed on top of the container that reads water-level 

inside tank, level read by the ultrasonic sensor determines whether the solenoid valve 

is working or not. The ultrasound sensor has two cables to trigger the ultrasound sensor 

and receive the ultrasound echo.  

 

In Addition to this a Capacitive Soil Moisture Sensor is also integrated to Node_MCU 

which is used to measure the moisture content present in the soil. These sensed values 

are monitored using Blynk mobile application. 

 

IOT Integration 

The Integration Between Node_MCU and Blynk App makes the project an IOT 

based project. The code is dumped to Node_MCU board using Arduino IDE by 

connecting it to computer. A new Authentication Token is generated when a new 

project is created in Blynk App. The Auth Token and Wi-Fi credentials in Arduino 

sketch are replaced with the ones obtained from the Blynk app. 

 

In Blynk App new templates and Datastreams are created depending upon the 

requirement. Here in this project one template is created for single device and two 

datastreams are created. One datastream is for water level monitoring at the pots and 

another datastream is for monitoring the moisture content present in soil. Depending 

upon the user’s convenience, dashboard is created for monitoring the created 

datastreams. 

 

All the data sensed by sensors are updated to created datastreams present in the blynk 

server through internet. This datastream values are shown in dashboard using gauges 

and super charts. 

  

4.1.4 Working Process 

The system can be controlled remotely via a smartphone using Blynk mobile 

application, allowing users to monitor and adjust the watering schedule as needed. 
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The working process of smart pot irrigation can be broken down into the following 

steps: 

1. Installation: The system is installed by burying the porous clay pots in the soil 

near the roots of plants and connecting them to a water source. The pots are 

fitted with sensors that measure soil moisture levels, temperature, and other 

environmental conditions. 

2. Sensor data collection: The sensors collect data on soil moisture levels and other 

environmental conditions and transmit this data to a controller or hub. 

3. Data analysis: The controller or hub analyzes the sensor data to determine the 

optimal watering schedule for the plants based on factors such as the type of 

plants, the local climate, and the soil type. 

4. Watering schedule creation: The controller or hub creates a watering schedule 

based on the sensor data analysis and sends this information to the system's 

pump or valve, which controls the flow of water to the pots. 

5. Watering: The pump or valve waters the pots according to the watering 

schedule, delivering the appropriate amount of water to the plants' roots. 

6. Remote monitoring and adjustment: The system can be monitored and adjusted 

remotely via a smartphone app or other web-based interface. Users can view 

data on soil moisture levels, temperature, and other environmental conditions, 

as well as adjust the watering schedule as needed. 

7. Maintenance: The system requires regular maintenance to ensure proper 

operation. The pots should be checked regularly for damage or clogging, and 

the sensors should be calibrated periodically to ensure accurate readings. 

Overall, connecting pot irrigation to iot offers a more efficient and effective way to 

irrigate plants, especially in areas with limited water resources. The system can be 

customized to meet the specific needs of different plants and can be adjusted as needed 

to adapt to changing environmental conditions. With proper maintenance, it can help to 

conserve water and promote healthy plant growth. 
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4.2 Results 

 
4.2.1 Testing Setup 

 
For monitoring and testing of Automated Pot Irrigation system we arranged an 

aquarium setup with two pots in it connected at the bottom filled with soil. 

 

 

 

 
 

Fig 4.5. Testing Setup 

 

 

 

4.2.2 Fenugreek Harvesting 

 
For testing purposes, we planted Fenugreek seeds, the water level inside pots 

and the moisture level of soil is monitored for over a period of 4 days. The results of 

monitoring plant growth, water level and moisture level from day 1 to day 4 are shown 

below in the form of graphs and images. 

 

 

 
 

  

Day 1 
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Fig 4.6. Plant Growth Images form Day1 to Day 4. 

 

 

 
Monitoring of water level at pots and Moisture level of soil is done in mobile through 

Blynk App. Two gauges are used to display the water level and Moisture level and two 

super charts are used which give the data of monitoring for over a long period of time 

like period ranges from 1 day to 3 months. 

 

 

Day 2 

Day 3 

Day 4 
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Mobile Dashboard for monitoring these datastreams is shown below. 

 

 

 

Fig 4.7. Blynk Mobile App Monitoring Window  
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4.2.3 Graphical Results 

 

 

 

Fig 4.8. Water Level vs Time. 

 

 

 
 

Fig 4.9. Moisture Level vs Time. 
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From the graphs above we can observe that water level in pots reduces in course of 

time. This occurs when the water splits out form the pores of unglazed clay pot due to 

which the soil surrounding the pots gets moisture.  

 

• It is clearly observed from the graphs, as the water level in pots reduces the 

moisture content of soil increases gradually. 

• The Moisture content is maintained at maximum level until the water level 

is greater than or equal to half of the pots water capacity. 

• When the water level is below 30% of pots water capacity the moisture 

content of soil gets gradually decreased. 

 

When the Water level falls less than 20% of pot capacity the relay module turns on and 

solenoid valve powers up, the water is drawn from overhead tank and water is filled in 

pots until the water level reaches 80% of pot capacity, when water level reaches above 

80% relay module turns off and this process continues. 
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CHAPTER 5 

CONCLUSION 

 

Watering plants is the most important cultivation technique and the most labor-

intensive task in daily plant cultivation. There may be some situations when the farmer 

himself cannot assist the crops. Automated Pot Irrigation System is one of the best 

solutions to monitor the crops far away. Through pot irrigation the problems faced by 

areas where there is a shortage of water are solved. 

 

This project Automated Pot Irrigation & IoT based monitoring system for irrigation is 

designed to help the regions where water scarcity is present, to reduce wastage of water 

and to help the farmers to monitor the crops when they are away from the field. 

 

➢ By implementing this project, we can save up to 50 –70% of water. 

➢ The complexity of imparting many sensors can be decreased. 

➢ Evaporation of water is minimum in this method. 

➢ The effective cost of the whole framework is diminished. 

➢ The wastage of water is reduced as only the required amount of water is drawn 

by plants. 

 

 

Future Scope:  

 

Only soil moisture and water absorption are monitored in this project. An additional 

advancement should be added to this project through which the plant growth and soil 

health can also be monitored. 

In order to monitor the soil health different factors should be taken into consideration 

such as temperature of soil, pH level, Nitrogen-Phosphorus-Potassium (NPK) content 

and various others. 
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